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General

Why Burn a Disc Image
Many data folders contain invisible data 

files that are used by the application that 
creates and modifies the contents of the 
folder. One example is iPhoto that uses the 
iPhoto Library folder. These invisible files 
could contain important information like 
the Keywords, or the alias directory for the 
Albums of iPhoto.

Unless special steps are taken, simple 
burn processes like “Burning in Finder 
View” will not capture these invisible files. 
The CD produced cannot fully restore 
the functionality of the original data. All 
images would be preserved but some image 
identification information can be missed.

A disc image of folders contains ALL 
the files, visible or invisible. The disc 
image process takes more time but all data 
is captured. Most data folders do NOT 
contain important invisible files. “Burning 
in Finder View” is sufficient for these 
folders. ~Jerry King

MacFriends Report, Naples, FL

Hard Disk Corruption
It has happened to many of us, and is 

not a pleasant experience: the computer 
starts to behave strangely and some files 
seem to mysteriously disappear. If your 
computer is showing these symptoms, it 
might be suffering from a damaged file 
system on its hard disk.

There can be many causes of this, 
including faulty hardware in your 
computer or a power cut at a critical point 

while the disk is being updated, but the 
most common cause is software bugs, 
either in the operating system itself or in 
an application or other piece of software on 
the computer.

If you think the file system on your hard 
disk might be damaged, you should stop 
using the computer as soon as possible, as 
any data written to your hard disk might 
cause further damage to the file system, 
possibly resulting in loss of files. Use disk 
repair software to check for and repair 
any problems before you resume normal 
operation. Mac OS X has improved the 
reliability of the file system considerably 
over Mac OS 9, simply by preventing 
applications from being able to write data 
to arbitrary locations on the hard disk, 
and from overwriting critical system files. 
In addition, Mac OS X 10.3 (and later) 
supports a scheme known as “journaling,” 
which allows it to recover from the 
computer crashing, restarting or losing 
power, and restoring the file system to a 
consistent state.

Unfortunately this system isn’t perfect, 
and it is still possible to get minor 
problems occurring on rare occasions. 
Sometimes these minor problems can grow 
into major ones, and once the file system 
has major damage, you are at risk of losing 
a lot of files on your hard disk. So, how 
does one deal with these problems, and 
hopefully catch them before they get too 
serious?

Disk Utility: First Aid
The primary tool on Mac OS X is the 

Disk Utility application. It includes a “First 
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Aid” component, which can check 
your hard disk for any file system 
damage, and repair simple problems. 
It is a good idea to regularly run 
Disk Utility and do a “Verify” on 
your computer’s hard disk to check 
for any problems. Hopefully this 
will catch any minor issues before 
anything serious happens.

Unfortunately, you can’t use the 
Verify (or Repair) function of Disk 
Utility unless you start up your 
computer from another disk. Apple 
has provided a method of doing this 
by including a copy of Disk Utility 
on the Mac OS X installation CD/
DVD which was supplied with your 
computer. They hid it a little, so you 
need to know where to look in order 
to find it: instead of clicking on the 

“Install” button, look in the Menu 
bar for Utilities > Disk First Aid.

In Disk Utility, you need to 
select your hard disk from the list 
on the left side, then make sure you 
have the “First Aid” tab selected, 
and click on the “Verify” button. 
This will check your disk for any 
problems. It displays progress 
information and a summary of what 
it found. If there are any problems, 
they will be shown in red, and it 
will say that you need to repair the 
disk. You can do this by clicking 
on the “Repair” button. Assuming 
the problem was minor, Disk First 
Aid should be able to fix it. When 
finished, you can quit from Disk 
Utility, and quit from the Installer, 
then restart your computer to 
return to normal operation.

Third-Party Disk Repair Tools
If there is a serious problem, 

Disk First Aid may not be able to 
repair it. This is when you need to 
call in the heavy guns in the form 
of specialist third-party disk repair 
programs. These are all relatively 
expensive, and it is important to 

ensure you are running the latest 
version. There have been cases 
where an old version of a disk repair 
utility has done serious damage to 
a file system that has been modified 
by newer system software.

In the past, the main disk repair 
was Symantec’s Norton Utilities. 
This program is no longer being 
developed, and, more importantly, 
the latest version is not compatible 
with Tiger, so I cannot recommend 
its use, and I would discourage 
anyone from buying it now.

In my experience, the best 
program for dealing with a 
corrupted file system is Alsoft’s 
DiskWarrior. It takes a while to 
rebuild the directory on your hard 
disk, then gives you the option 
of previewing its results before it 
actually modifies your hard disk. 

If it has not succeeded in 
recovering files you know were 
lost, you can cancel DiskWarrior’s 
repair attempt, and try other repair 
tools first. DiskWarrior is certainly 
a lot easier to use than Norton 
Utilities, as it doesn’t ask mysterious 
technical questions whenever it 
encounters a problem.

Another major disk repair 
program is TechTool Pro, which 
also provides a wide range of other 
tests for your computer hardware. I 
have this, but I’ve never needed to 
use its disk repair functions because 
DiskWarrior has always done a good 
enough job, so I can’t comment on 
its reliability or usability.

Another useful program is 
Data Rescue. This concentrates on 
recovering files from a damaged 
hard disk rather than trying to 
repair it. If you have files on your 
hard disk that have been lost, are 
absolutely critical, and you must 
recover them at all costs, I’d 
recommend trying this one before 

anything else, though I haven’t 
had need for it myself. All of these 
programs cost around $80 to $90.

The Aftermath
If you were suffering from major 

damage to your file system, then 
you may find that the computer is 
still misbehaving after the damage 
has been repaired. The most likely 
explanation is that some critical 
system files were partially damaged, 
and they need to be reinstalled. You 
should try doing a fresh installation 
of your operating system, and 
preferably all your applications as 
well, or restore everything from a 
known good backup.

Optimization?
Some disk tools offer a method of 

optimizing your hard disk in order 
to improve performance. If you are 
running Mac OS X, I’d recommend 
avoiding this. The speed gains are 
temporary, and the optimization 
process is risky: if the file system is 
already damaged, optimizing it is 
likely to cause serious damage.  
~David Empson

Wellington Macintosh Society,  
Wellington, New Zealand  

via TMUG Insider, Pleasanton, CA 

Get More Respect
Even though software 

applications seem like they’re in 
English, they’re really a foreign 
language. And like a foreign 
language, if you want to get respect 
from the natives, you need to learn 
the terms. 

Every item that does anything 
in an application has a name. Every 
little box, control and interface item 
has a name: Title Bar, Close Box, 
Zoom Box, Field, Radio Button, 
Check Box, Toolbar, etc. Knowing 
these terms lets you communicate 
clearly with others, especially when 
you’re having trouble. Not knowing 
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them can alienate and frustrate 
those wanting to help, and leave you 
frustrated as well. Take the time 
to learn some of the terms. They’re 
usually mapped out at the back of 
the manual that came with your 
application, or the book you bought 
to learn your application.

Design Tools Monthly

There is a Difference
Just about all applications 

(programs) use a window to display 
whatever it is you are working with 
or reading (normally described as 
a “document”). Mac OS X windows 
display the buttons in their upper 
left corners, to close, minimize, 
and zoom the window, respectively. 
(The close button for an OS 9 
window is also in its upper left 
corner.)

When you have finished with 
an application and want to clear 
the screen so that you can go 
on to other work, there are two 
ways of doing so: you can quit 
the application (using the menu 
command [Application name] 
> Quit, or in Mac OS 9, File > 
Quit), or you can simply click the 
window’s Close button.

What is really important to 
understand is that apart from 
closing the document you’ve been 
working with, these two actions are 
not the same.

By using the menu command 
to Quit, you are not only closing 
the window (document) but also 
completely closing the application 
so that it is no longer occupying any 
of the Mac’s memory or requiring 
any of its processor’s attention.

On the other hand, simply 
clicking the window’s Close 
button does nothing but close the 
particular document you were 
working with—the application 

remains open ready to work on 
another document of the same type. 
Even if you don’t open any such 
document, the application itself 
remains open, occupying at least 
some of the Mac’s memory space 
and requiring at least some of its 
attention.

In Mac OS 9 this is really bad 
news—the application occupies the 
same amount of memory whether 
it is working on a document or 
sitting idle, and if you leave several 
applications open you will soon run 
out of usable memory.

In Mac OS X the situation 
is much less critical, since an 
application uses only as much 
memory as it actually requires from 
moment to moment, so that even 
if an application is left open, it 
uses very little memory if it is not 
working on a document.

Still, it is arguably not good 
housekeeping practice to leave 
numerous applications open if 
you are not using them. Why 
complicate your Mac’s life 
unnecessarily?

A good reason for not leaving 
idle applications open is that it may 
inhibit a proper understanding of 
what your Mac is doing, particularly 
if you are a relative beginner. On 
many occasions I’ve had people 
say to me, “If I have application 
so-and-so open and then close it, 
next time I try to open it nothing 
happens.” What’s happening here 
is that after using the program and 
simply closing its window (rather 
than Quitting it properly), they 
then double-click its icon and are 
surprised when no window opens.

The reason is that the application 
opens a new window only when it 
is launched for the first time. If it is 
already open, double-clicking does 
not open a new window—double-

clicking an already-open application 
simply brings it to the front (so that 
its name appears in the menu bar at 
the top of the screen, along with its 
particular menu items) but nothing 
else happens.

The moral is that, at least until 
you understand how your Mac 
works and can make an informed 
decision otherwise, always close 
a program you are finished with 
by using the menu command File 
> Quit, rather than just closing 
a window using the red button. 
~Steve Cooper
AUSOM News, Melbourne, Australia

Get Ready for 64-Bit
On its web site, the Apple 

Developer Connection (ADC) 
has published an article titled 

“Developing 64-Bit Applications 
Coming with the release in 2005 of 
Mac OS X v 10.4 (Tiger).” 

The article explains the switch 
from 32- to 64-bit computing. This 
change will allow developers to 
go beyond the 4GB limitation on 
RAM on each application currently 
imposed by Mac OS X. 

Tiger allows 16 exabytes, or 16 
billion gigabytes. This is enough to 
hold 16,000 copies of the Internet 
Archive. No computer can hold that 
much memory, but it will allow a 
lot of headroom for the future. 

You can read more on the Apple 
Developer Connection site.
Apple Pickers MUG, Indianapolis, IN

PMS Colors for Flags
Printed versions of the flags of 

most nations use only these PMS 
colors: Red 032; Green 354; Yellow 
109; Orange 021; Gold 116; Process 
Blue; Blue 286; UN Blue 279; 
Intermediate Blue 300.

PC Graphics Report  
via Design Tools Monthly
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Phony Contacts
Q: I have a new Motorola V600 

Bluetooth-enabled phone. My 
PowerBook G4 can see the phone 
and pair to it using a Bluetooth 
adapter, but iSync won’t recognize it. 
If Bluetooth can see the phone, isn’t 
there some tweak to get iSync to see 
it as well? ~Ricky P. Clay

A: Currently, no. But there are 
a couple of ways to move contacts 
to phones that don’t have iSync 
support. The first is to use Antonio 
Ferraioli’s $10 OnSync. OnSync 
allows you to move contacts from 
OS X’s Address Book, Microsoft 
Entourage, Qualcomm Eudora, and 
Now Contact (part of Now Up-to-
Date & Contact) to the V600 and 
other phones. (However, OnSync 
doesn’t support calendar events of 
any kind.)

Your other option is to use 
Address Book’s “Send These Cards” 
command. Just pair your phone to 
your PowerBook; then, in Address 
Book, select the contacts you 
want to transfer to the phone, and 
choose “Send These Cards” from 
Address Book’s Card menu. In 
short order, your phone will ask 
you to accept the transfer. Do so 
and store your contacts.

Chris Breen’s Mac 911  
via The Finder, Mid-Columbia MUG, 

Kennewick WA

Mac OS X

Frustrating File Sharing in OS X
Q: I used OS 9 for many years 

and I’ve just recently upgraded 
to OS 10.3. OS 9’s File Sharing 
allowed me to share the hard disks 
between all my Macs. I could 
mount them on the desktop and 
drag and drop files from one 
computer to the other rather easily. 

I can’t figure out how to do this 
with OS X. 

I can set up file sharing so that 
everyone can access the Public 
Folders, but that’s just plain 
annoying. I want to drag and drop 
a file into the Documents folder 
on another Mac. I do not want to 
toss it in the Public Folder’s Drop 
Box, run across the room to the 
other computer, fish it out of the 
Drop Box and then put it into 
Documents. That’s insane! Please 
tell me there’s an easier way to go 
about this task. ~Brad Edwards

A: Yes, there is an easier way to 
share files. You’re forgiven for being 
confused, though; OS X’s Personal 
File Sharing setup text implies that 
you can only “give users of other 
computers access to Public folder on 
this computer.” In reality, you can 
access anything on any computer so 
long as you have its administrator 
name and password.

Go to the first computer, choose 
“System Preferences” from the 
Apple Menu and click “Sharing.” 
Choose “Personal File Sharing” 
from the list of services and click 

“Start.” Repeat this process for each 
computer. Now return to the first 
computer. Go to the Finder and 
choose Go > Connect to Server. 
Click “Browse,” and you’ll be taken 
to a Finder window showing all 
available servers. Double-click a 
computer you want to access to 
call up the login window. Choose 

“Registered User” and then enter the 
administrator name and password 
for that computer. Don’t click 

“Connect;” instead, click “Options.” 
You’ll see that you can choose to 
add the password to the keychain. 
This is especially useful if you’re 
going to be connecting to the 
computer on a regular basis. Choose 
the option to “Add Password 

to Keychain” and click “Save 
Preferences.” Click “OK,” then click 

“Connect.”
You’re then asked to choose the 

volume you wish to mount. You 
can choose to access the entire 
hard disk or just the user account. 
(Command/Click to choose 
multiple volumes.) 

Once the volume appears on 
your desktop, drag it to your Dock 
for quick access. Assuming you’ve 
chosen to add the computer’s name 
and password to your keychain, 
you’ll be able to automatically 
connect to the volume at anytime 
with a single click.

macHOME Journal

Moving Items Around in the 
Dock

You can drag items into any 
position you want in the dock as 
long as they are on the proper side 
of the dock separator.

Small Dog Electronics  
www.smalldog.com

Eye (Want) Candy
Q: When using fast-user 

switching in Mac OS X Panther, my 
400MHz Power Mac G4 doesn’t 
show the cool rotating-screen effect. 
Why not?

A: Mac OS X 10.3 Panther uses a 
technology called Quartz Extreme 
to accelerate and enhance the way 
your Mac draws information on the 
screen. One of these enhancements 
is the rotating-screen effect you 
mentioned. Unfortunately, Quartz 
Extreme requires certain newer 
video cards in order to work. Your 
Mac’s older video card can handle 
Panther, just without the benefits of 
Quartz Extreme (www.apple.com/
macosx/features/quartzextreme). 
To use Quartz Extreme, you need 
either an Nvidia GeForce2 MX, 



November 2005 • Page �www.mac-hints-tips.com

GeForce3, GeForce4 MX, or 
GeForce4 Ti, or any AG P-based 
ATI Radeon card.

MacAddict Magazine

Allow SSH Access to Limited 
Users in Mac OS X’S Terminal 
Application

Using a ssh session, you can 
easily connect to your Mac from 
virtually any computer in the 
world. But what if you only want 
a few people to have access to 
your computer via ssh, even if they 
have valid accounts? For example, 
although a student may have an 
account on a lab computer, you may 
not want to grant her ssh access.

To limit access to certain users, 
launch a Terminal session and enter:
sudo vi/etc/sshd _ config

Then, add the following to 
the end of the file, replacing the 
appropriate short usernames with 
the user1 and user2 values:
AllowUsers user1 user2

As long as you separate the 
users by a space, you can add as 
many usernames as you like. Save 
the change, and then restart your 
computer. From that point on, only 
users listed in the line will be able 
to access the computer. To grant 
everyone access again, just remove 
the line and reboot the computer.

TMUG Insider, Pleasanton, CA

Activity Monitor: Your Secret Ally
We use Apple’s Activity Monitor 

to help troubleshoot problems in 
both Mac OS X 10.3 and 10.4 
when our Macs are acting sluggish. 
Activity Monitor lists applications 
and other processes that are 
currently running on your Mac.

Click the pop-up menu at the 
top of the window and choose “All 
Processes” to see everything that 
is running, including hidden and 

invisible applications. Click the 
“%CPU” column to sort the list 
according to how much of your 
processor’s cycles are being used 
by each process. The higher the 
percentage, the more likely it is that 
you have found what is slowing 
down your Mac. You’ll find Activity 
Monitor in Applications > Utilities.

Design Tools Monthly

iPhoto

Family Album
Q: My son and I share an iMac 

at home. Is there a way for us to use 
the same iPhoto library? 
~Kiki Mulliner

A: With the proper privileges, 
this can be done with aliases. It 
works this way: Choose the most 
up-to-date iPhoto Library folder 
(located at your user folder/Pictures) 
and move it to the Shared folder 
inside the Users folder at the root 
level of the hard drive. Click on 
the iPhoto Library folder, press 
Command/I to call up the iPhoto 
Library Info window, click on the 

“Ownership & Permissions” triangle, 
and then click on the “Details” 
triangle below. Select “Read & 
Write” from the Access pop-up 
menu directly beneath the Group 
pop-up menu, select “Read & Write” 
from the Others pop-up menu, and 
then close the Info window. Hold 
down the Command and Option 
keys and drag the iPhoto Library 
folder back to the Pictures folder to 
create an alias.

Switch to your son’s user account, 
change the name of his iPhoto 
Library to something like “iPhoto 
Library Old” (in case you want to 
use this library again), open the 
Shared folder within the Users 
folder, and Command/Option/drag 

that folder’s iPhoto Library folder to 
your son’s Pictures folder to create 
an alias.

Chris Breen’s Mac 911  
via TMUG Insider, Pleasanton, CA

iPhoto Smart Albums
The concept of Smart Albums, as 

implemented in iPhoto 4 and later, 
has made my task of managing the 
2500 photos I brought back from a 
recent vacation so much easier than 
it was last time.

Smart Albums are albums whose 
content is defined not by dragging 
photos into them, but rather by 
setting “rules” for determining 
photo eligibility and letting iPhoto 
move items in and out automatically 
as you work. The criteria can be 
quite complex, working with your 
photo ratings, keywords, existing 
albums, photo dates, and more. 
Once you’ve defined the criteria, 
iPhoto moves all the qualifying 
photos into the Smart Album, and 
then updates the album content as 
you work, allocating or removing 
ratings, keywords and so on.

You can adjust your selection 
criteria at any time and the Smart 
Album content will immediately be 
revised accordingly.

To get iPhoto 4 you need to buy 
either a new Mac or the iLife suite, 
the latter for $79. ~Steve Cooper
AUSOM News, Melbourne, Australia

iPod

Fit More Songs on iPod Shuffle
If you’re after the highest 

quality tunes and regularly import 
songs at bit rates higher than 128 
Kbps, iTunes offers you the best 
of both worlds, letting you keep 
your high-quality songs in iTunes 
while exporting leaner versions of 
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the songs, sized just right for iPod 
Shuffle. 

Here’s how: Connect iPod shuffle, 
open the iPod Preferences dialog, 
and click the iPod tab. Click the 
check box next to “Convert higher 
bit rate songs to 128 kbps AAC for 
this iPod.” Then click OK. 

The next time you Autofill iPod 
shuffle, iTunes will automatically 
convert songs to 128 Kbps as it 
exports them to iPod shuffle. The 
original versions in your iTunes 
collection, meanwhile, will remain 
in your library at their higher 
encoding rate.

Apple eNews

iTunes

How To: Smart Playlists
Many people have found out 

about Smart Playlists in iTunes and 
used them. But others have not, and 
even those who have found them 
don’t really know how to put them 
to best use.
http://www.themacmind.com/
modules.php?op=modload&name=
News&file=article &sid=692

The MUG Center  
www.mugcenter.com 

via TMUG Insider, Pleasanton, CA

Song Saving
Q: When I recently opened an 

MP3 file in iTunes, all my music 
and playlists had disappeared. I 
found my music in the Documents 
folder and imported it back into 
iTunes, but all my playlists are still 
missing. How can I recover them? 
~Jeremy Hahn

A: It sounds as though you have 
a corrupted iTunes 4 Music Library 
file. To fix it, quit iTunes, open your 
iTunes folder (stored by default in 
your user folder’s Music folder), and 

drag any iTunes Music Library files 
to the Trash. (You may have more 
than one of these files if you’ve used 
older versions of iTunes with this 
computer.)

Now drag the iTunes Music 
Library.xml file to the desktop. 
Launch iTunes and choose “Import” 
from the File menu. Navigate to the 
iTunes Music Library.xml file on 
the desktop and click on “Choose.” 
Importing this file should cause 
your playlists to appear in iTunes.

If you have an iPod that contains 
the playlists from your Mac, you 
can also use a utility such as 
CrispSofties’ iPod.iTunes. In 
addition to copying music files from 
an iPod to your Mac, iPod.iTunes 
will synchronize playlists between 
the two. If you’ve lost the playlists 
on your computer, iPod.iTunes 
should be able to restore them from 
the copy stored on your iPod.

Chris Breen’s Mac 911  
via Fat Bits, Ventura CA

Toast & Jam

Better Audio Burning Playlist
iTunes is a great tool for ripping, 

encoding, and managing your 
music, and it’s free, but even Apple 
wouldn’t claim that it’s the be-all 
and end-all for creating audio 
CDs. iTunes just doesn’t have some 
advanced features. With a program 
such as Roxio’s Toast Titanium, 
Jam, or Toast with Jam, you can do 
more with your music and create a 
greater variety of audio discs.

Making Copies
Backing up audio CDs with 

iTunes is a tedious process. You 
need to rip them as AIFF files 
(by going to iTunes’ Importing 
preference pane and changing 
the “Import Using” setting to 

AIFF Encoder) and then burn the 
resulting files back to a CD-R. 
And OS X’s Disk Utility won’t let 
you create an image of an audio 
disc. But Toast makes duplicating 
audio CDs easy by letting you 
copy an audio CD directly from 
one optical drive to another. If you 
have multiple burners, just choose 
the drive you want to copy from in 
the “Read From” pop-up menu (see 

“Burner Bonanza”), and choose the 
drive you want to record with in the 
pop-up menu that appears at the 
bottom of the Toast window. Then 
click on the “Record” button and 
watch as Toast copies your disc.

Toast also gives you the option 
of saving audio CDs as disk images 
(instead of copying them directly to 
blank CDs)—ideal if you have only 
one burner or if you plan to make 
multiple copies of a disc. You can 
also mount these images and they 
will play back in iTunes as if they 
were physical audio CDs.

And when burning audio CDs, 
iTunes creates a plain-vanilla disc. 
If you’d like to create an enhanced 
audio CD that also includes 
pictures and text, or if you want 
to fashion a disc that includes CD-
Text (information such as the album 
and song title that appears in the 
display of compatible players), a tool 
such as Toast is necessary.

Mind the Gap
One of iTunes’ aggravating 

quirks is its inability to create discs 
with seamlessly connected tracks.

For example, the last several 
tracks of the Beatles’ classic Abbey 
Road album flow continuously. But 
even if you configure iTunes so it 
doesn’t put a gap between the tracks 
when you burn them to disc (as you 
can in iTunes’ Burning preference 
pane), you’ll still hear a tiny hiccup 
between songs.
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If you think you might burn 
audio CDs from your ripped music, 
consider joining multiple tracks 
into one at the time of import 
(Advanced > Join CD Tracks). 
However, this leaves you with long 
tracks that you can’t navigate easily. 
And suppose you want no gap 
between tracks two and three, but a 
two-second gap between tracks five 
and six? iTunes can’t help you.

Toast supports a feature called 
Disc-At-Once (DAO) that keeps 
the laser on between the tracks 
it’s burning. DAO maintains the 
seamless track flow when burning 
a CD from uncompressed files on 
your Mac, copying from one CD 
to another, or copying from a disk 
image to a CD. It also lets you 
record tracks with gaps of different 
lengths between them (the program 
offers gaps from zero to eight 
seconds long).

Creating a seamless CD from 
compressed (MP3 or AAC) files 
in your iTunes library is a different 
matter, however. To create smooth 
transitions between iTunes tracks, 
you need a tool that can cross-fade 
one track into another (in other 
words, overlap portions of each 
track and fade the first track out 
while fading the second in). iTunes’ 
cross-fade feature affects only 
playback in iTunes, not burning. 
Although Toast doesn’t include a 
cross-fade feature, its professional 
sibling – Jam—does. (Note that 
with Tiger and QuickTime 7, you 
can no longer use Toast or Jam to 
burn protected AAC files.)

With Jam, you can not only 
impose cross-fades on tracks and 
burn those effects to disc, but also 
change the cross-fade’s shape and 
duration. This allows you to create 
a more natural-sounding cross-fade, 
one that’s likelier to cover up the 

audio hiccup that occurs between 
tracks. As with Toast, you can pick 
gaps of different lengths between 
tracks—although with Jam, these 
gaps can be of any length (perfect if 
you want that surprise bonus track to 
begin 45 seconds after your listener 
thinks the last track has ended).

Added Features
Toast and Jam (and Toast with 

Jam, which includes both apps and 
additional Toast features) perform 
other tricks that iTunes can’t.

Support for High-Resolution 
Files: iTunes can convert the files 
it supports (44.1kHz and 48kHz 
AIFF, WAY, MP3, AAC, and Apple 
Lossless files) to a format compatible 
with audio CDs, but it doesn’t 
know what to do with higher-
resolution audio files—files created 
in professional audio applications 
with special hardware. Toast and 
Jam can burn an audio file of up to 
192kHz and 64 bits to a standard 
audio CD. The Toast with Jam 
package can even add Dolby Digital 
files to an audio CD.

DYD Audio Discs: Although 
iTunes can back up your music 
as data to a DVD-R disc, you 
can’t play these discs in regular 
AV equipment. Toast with Jam 
can create DVD Music Albums—
DVDs with as much as 36 hours 
of two-channel, Dolby Digital-
encoded music (less in PCM 
format). The discs include basic 
navigation menus and on-screen 

“now playing” information, and 
a standard DVD player will play 
them.

Convert and Restore LPs and 
Tapes: You can use iTunes to rip 
CDs but not to record audio from 
a computer’s audio-input port. 
With CD Spin Doctor (a program 
included with Toast and with 
Roxio’s Boom Box), you can record 

your old LPs and tapes to your Mac. 
The program can recognize gaps 
between songs and automatically 
segments albums into tracks for 
you. It can also remove pops and 
crackles.

Track and Album Normalizing: 
iTunes includes the “Sound Check” 
feature that balances the volume 
of tracks so they more closely 
match one another. This isn’t 
always a desirable effect, because 
audio engineers purposely master 
recordings so that some tracks are 
quieter than others, and when you 
impose Sound Check, you lose 
the balance between soft and loud 
recordings on an album. 

Jam lets you balance (normalize) 
tracks either individually or in 
groups; you’d balance them 
individually to give tracks from 
different CDs the same volume, or 
you’d balance a group of tracks to 
increase an album’s overall volume 
without boosting all the tracks to 
the same volume.

Chris Breen’s Mac 911  
via TMUG Insider, Pleasanton, CA

MS Word

Word’s Keyboard Shortcuts
Microsoft Word is a powerful 

and complex word processor with 
hundreds of predefined keyboard 
shortcuts. Here’s how to create a 
printout of all of Word’s shortcuts. 
In either Word v. X or 2004, select 
Tools: Macro: Macros to open the 
macro dialog box. In the Macro 
Name field, type ListCommands 
and then click on Run. In the 
next dialog box, select All Word 
Commands, and then click on OK 
to start the macro. A new document 
will appear on your screen, listing 
every single Word command along 
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with the associated keyboard 
shortcut(s).
Apple Pickers MUG, Indianapolis, IN

Display Built-In Styles
When you create a document, 

Word starts you out with a handful 
of basic styles. If you need to apply 
a more specialized style, hold down 
Shift and click on the arrow beside 
the “Style” box on the Formatting 
toolbar. Word will expand the Style 
list to include all its built-in styles. 
Just select the one you need and 
Word will apply that style and add it 
to your document.

TMUG Insider, Pleasanton, CA

FileMaker Pro

Smart Duplication
When you duplicate an object, 

it’s offset 6 pixels to the right and 6 
pixels down, unless you’ve changed 
the ruler settings from the default. 
However, the duplicate feature 
works differently if you move the 
duplicated object with the arrow 
keys or the mouse. As long as you 
don’t deselect the duplicated object 
while moving it, a second duplicate 
will be offset the same number of 
pixels as the first duplicate from 
the original. This is useful when 
you’re creating multiple objects 
offset exactly the same distance and 
can be much more efficient than 
applying arrangement options after 
you’ve duplicated the objects.

FileMaker

Build a Simplified Contact 
Management System

In previous versions of FileMaker 
Pro, creating buttons to mimic a 
rolodex required 26 scripts. Each 
script differed only by the letter 
of the alphabet you entered into 

the last name field in find mode. 
To make any changes, you had 
to modify all 26 scripts, not to 
mention the tremendous amount 
of clutter 26 scripts creates in the 
ScriptMaker dialog.

Fortunately, in FileMaker Pro 7, 
script parameters can put an end to 
needless duplication of scripts. Here’s 
an example of a single script attached 
to multiple buttons and varied 
through script parameters to search 
by all 26 letters in the alphabet:
Set Error Capture [On]
Enter Find Mode []
Set Field [ROLODEX::
Last Name; 
Get(ScriptParameter)] 
Perform Find [] If 
[Get(LastError) = 401]

Show Custom Dialog 
[“Error”;

“No names beginning with 
\”

& Get(ScriptParameter) & 
“\”

were found. All names 
will be shown.”]

Show All Records
Else
Go to Layout [“List”]
End If

The notable new option 
in this familiar script is the 
Get(ScriptParameter) function used 
in the Set Field and Show Custom 
Dialog steps. 

The script parameter was assigned 
at the button level inside the 
Perform Script step so the script 
could be reused on many buttons. 

The calculation the script 
parameter passes is simple, 
consisting of a letter from the 
alphabet enclosed in quotes. 

The Set Field step simply places 
the script parameter, from the 
button you click, into find mode. 

The Show Custom Dialog step 

also uses the script parameter to 
display an error message when it 
doesn’t find any records, customized 
with the find criteria from the 
button clicked.

FileMaker

Illustrator

A Better Outline Mode
When working in Illustrator’s 

Outline mode, all graphics display 
at their most basic: paths and boxes. 
If you would like to maintain most 
of the speed of working in Outline 
mode, but still see your placed 
images, choose File > Document 
Setup and enable the checkbox 
named “Show Images in Outline 
Mode.” Your placed images will 
then appear in low resolution when 
you work in Outline mode.

PC Graphics Report  
via Design Tools Monthly

Faster Display in Illustrator CS
You can adjust Illustrator CS’s 

display performance by choosing 
Preferences > Units & Display 
Performance, then moving the 
slider between “Full Quality” and 

“Faster Updates.”
Design Tools Monthly

InDesign

Editing Images
Generally speaking, you should 

size and rotate graphics in their 
originating application rather than 
in a page layout program. This 
prevents raster images from losing 
resolution and becoming pixilated, 
and it prevents vector graphics 
from losing trapping settings and 
printing out of register. 

To open placed graphics in the 
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default application assigned by 
your operating system from within 
InDesign, Control/click on the 
selected graphic and then choose 

“Edit Original” from the Graphics 
submenu in the resulting context 
menu. After you save the file, the 
preview is instantly updated in your 
InDesign document. 

If a particular graphic file format 
doesn’t open in its originating 
application, such as Adobe 
Photoshop, you simply need to 
change the default. To do this, 
select any graphic file saved in the 
file format for which you want to 
change the default. Then, choose 

“Get Info” from the File menu. 
In the resulting dialog box, 

display the “Open With…” pane 
and choose the application you 
want to use to open that file 
format with. On the General tab 
in the Properties dialog box, click 
the “Change” button, select an 
application, and then click “OK.”

LIMac Forum, Long Island, NY

Add Space Between Objects  
in InDesign

Let us say that you’ve got five 
frames and you want exactly two 
picas between each of them. The 
Align palette doesn’t appear to let 
you specify an amount of space 
between objects. Or does it? 

Choose “Show Options” from 
the palette’s menu and suddenly 
you can. Turn on the Use Spacing 
checkbox to type in the amount of 
space you want between the selected 
items. ~David Blatner

LIMac Forum, Long Island, NY

Transparency Only in a Group
Perhaps you want a frame or line 

to be transparent to some objects 
on your page but not others. If you 
group that object with one or more 

others and then turn on “Isolate 
Blending” in the Transparency 
palette, the Blending Mode for 
each object will apply only within 
that group and not affect any other 
objects on the page. However, this 
only affects blending modes, not 
the Opacity setting.

David Blatner’s Tips & Tricks  
by ALAP, Inc.

Open Text Frame Options
You can open the Text Frame 

Options dialog box by pressing 
Command/B, but sometimes it is 
even faster to Option/double-click 
with the Selection or Direct Select 
tool.

David Blatner’s Tips & Tricks  
by ALAP, Inc.

Select Text in a Cell
When you select all the text in 

a cell b dragging the cursor, you 
sometimes select the cell itself 
(rather than the text). To select just 
the text, place the cursor in the cell 
and either type Command/A or 
press the Escape key twice. (The 
first time you press it, you select the 
cell; the second time deselects the 
cell and selects just the text inside 
the cell.)

InDesign Magazine

Breaking Underscores
The problem with underscores 

(underlines) is that they cross right 
over the descenders in characters 
like “p” and “y”. 

You can make the underscore 
break at descenders by applying 
a 1-point white stroke to those 
characters. Use Find/ Change to 
search for the letter “p” with an 
underscore and apply a stroke to it. 
Now repeat for “y” and so on.

David Blatner’s Tips & Tricks  
by ALAP, Inc.

Tracking Type
Usually, the larger the type size, 

the more tightly it needs to be set, 
so you can use negative tracking 
values. Condensed typefaces (like 
Futura Condensed) can also usually 
do with a little tighter tracking. 
Sometimes even applying a setting 
as small as –10 to a text block will 
help it hold together visually better.

David Blatner’s Tips & Tricks  
by ALAP, Inc.

Photoshop

How to Think About Color
I’d like to share with you a few 

ideas of how to think about color in 
Photoshop.

Right now, head on over to 
Photoshop, open any RGB mode 
image and choose Window > Info. 
That should make the Info palette 
visible somewhere on your screen. 
The Info palette measures the 
color that is currently under your 
cursor. The left side of the Info 
palette usually reflects the mode 
your image is in (RGB, CMYK, 
etc.). The right side is usually set to 
display CMYK numbers. You can 
change how Photoshop is measuring 
color by clicking on the tiny 
eyedropper icons that appear next 
to the numbers in the Info palette. 
Since you have an RGB image 
open and probably have the default 
settings, your Info palette should 
have RGB on the left and CMYK 
on the right. If that’s not the case, 
then click on the eyedropper icons 
I mentioned a second ago and set 
the left to RGB and the right to 
CMYK. Now let’s figure out how 
the Info palette can help us to 
adjust the colors in our images.

Let’s look at the relationship 
between the right and left sides of 



Page 10 • November 2005 www.mac-hints-tips.com

the Info palette (assuming you have 
them set up like I mentioned in the 
previous paragraph). The left side 
of the palette will measure things 
based on light—Red, Green and 
Blue light that is—while the right 
side will use ink. The C in CMYK 
is directly across from the R in RGB 
because Cyan inks’ sole job in life is 
to absorb red light. M is across from 
G because Magenta ink absorbs 
green light, and Y is across from B 
because Yellow absorbs blue light. 
If that doesn’t seem to be all that 
exciting, then try this:

With any RGB mode photograph 
open, choose Image > Adjustments 
> Curves. When Curves appears, 
click anywhere on the diagonal 
line that appears and drag up or 
down. Dragging up should brighten 
the image (adding light), while 
dragging down should darken the 
image (taking away light). When 
you’re done playing with that dot, 
then drag it off the grid area to get 
back to normal. Now, let’s see how 
we can use one of those dots to shift 
the color of an image.

Change the Channel menu that 
is found at the top of the Curves 
dialog box to Red and try the same 
dot experiment. You should notice 
that moving the dot up towards 
the word Red (that’s at the top of 
the Curves dialog box) makes the 
image more red, while moving it 
away from the word Red will make 
it the opposite of red, which is Cyan 
(remember C is across from R in the 
Info palette, which indicates Red’s 
opposite is Cyan). Next, drag that 
dot off the grid, change the menu at 
the top of the Curves dialog box to 
Green and do the same experiment. 
You should notice that moving the 
dot up towards the word Green 
makes the image greener, while 
moving it down makes the image 

more magenta. Finally repeat the 
experiment with Blue chosen in 
the pop-up menu. Now do you see 
how the Info palette can help you 
to figure out what will happen when 
attempting to shift the overall color 
of an image?

Ok, now let’s get our adjustment 
to be much more concentrated on 
an area of the image we’d like to 
work with. With the pop-up menu 
at the top of the Curves dialog 
box set to Red, move your mouse 
over the image and hold down the 
mouse button. You should see a 
circle appear in the Curves dialog 
box. That circle indicates which 
part of the curve you’d need to 
change in order to concentrate 
your adjustment on the color your 
mouse is over. To add a dot where 
the circle is showing up, hold down 
the Command key and click on the 
image once again. Once the dot is 
added, use the up and down arrow 
keys on your keyboard to shift that 
area of your image towards Red (up), 
or Cyan (down). You can repeat 
this process on the Green and Blue 
curves to shift the overall feeling of 
an image (warm, cool or neutral) 
towards any color you desire.

Ben Willmore  
www.digitalmastery.com

Smart Objects, Take 2
You’ve probably heard that 

Smart Objects are great to work 
with Illustrator files in Photoshop. 
Just place an EPS or .ai file in as a 

“Smart Object” and Photoshop will 
always reference the original file. 

This works great because you can 
edit the Smart Object in Illustrator 
and have the changes updated 
automatically in Photoshop. But 
you can expand this idea even 
further by placing a RAW file into 
Photoshop as a Smart Object. 

If you later realize that your 
exposure is off or you’d like to 
adjust any other settings, just 
double-click on the layer thumbnail 
in the Layers palette and you’ll be 
transported back to the Camera 
Raw dialog. Once there you can 
make all the adjustments you need. 
Click “Done” and your changes will 
be updated in Photoshop.

Layers Magazine

Smart Objects, Take 3
If you duplicate a Smart Object 

layer (Command/K) in Photoshop 
CS2, any changes made to one 
copy of the Smart Object layer will 
automatically be reflected in the 
duplicate Smart Object. 

But what if you actually want 
two separate copies of the Smart 
Object? Instead of duplicating the 
Smart Object layer, you’ll need to 
choose Layer > Smart Objects > 
New Smart Object via Copy. This 
will create a separate duplicate of 
the Smart Object that can be edited 
independently of the original.

Layers Magazine

Camera Raw
This time around, let’s explore 

Photoshop CS’s Camera Raw dialog 
box. You can only access this dialog 
box by opening an image that was 
shot with a digital camera in RAW 
mode (it doesn’t work with JPGs, 
TIFFs or any other file format).

If you’re using a Nikon camera, 
and you get a small dialog box 
that only has a few choices when 
opening an image from the camera, 
you’ll need to disable the Nikon 
plug-in. 

Navigate to the Photoshop 
> Plug-Ins > Adobe Photoshop 
Only>File Formats folder and 
remove the file named Nikon NEF 
Format and then restart Photoshop.
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Camera Raw has some 
sharpening controls (found under 
the Detail tab in Camera Raw) 
but I personally prefer to sharpen 
my images in Photoshop where 
I have a better command of the 
sharpening by using the Unsharp 
Mask filter. But before I get the 
image into Photoshop, I still like to 
see a somewhat sharp image within 
the Camera Raw dialog box. To 
accomplish that, you’ll need to first 
switch to Advanced mode near the 
upper right of the Camera Raw 
dialog box, then choose Preferences 
from the side menu of the dialog 
box (it looks like a triangle inside 
of a circle) and set the Apply 
sharpening to pop-up menu to 
Preview images only.

The default setting for Color 
Noise Reduction (found under 
the Detail tab) is 25. I find that’s 
way too high for most images and 
would instead prefer a default of 
somewhere around 5. To change 
the default, choose Camera Default 
from the Settings pop-up menu that 
appears just below the histogram, 
click on the Detail tab, set the 
Color Noise Reduction setting to 
what you desire and then choose Set 
Camera Default from the side menu 
of the Camera Raw dialog box.

The choice we just talked about 
was called Camera Default for a 
reason. Each camera you use can 
have different Camera Raw default 
settings. That means that you can 
customize the settings for older 
cameras that might require more 
noise reduction, or modify the 
settings found under the Detail tab 
if you find the default view of your 
image’s contrast to be too low.

After adjusting an image in the 
Camera Raw dialog box, you have 
two options of what to do next: 
Update the image and return to the 

File Browser, or open the image in 
Photoshop. Clicking the OK button 
will do three things: 

1. Open the image in Photoshop, 
2. Attach the Camera Raw 

settings to the RAW file so that 
those settings will be used the next 
time the RAW file is opened, 

3. Update the thumbnail and 
preview images shown in the File 
Browser to reflect the new Camera 
Raw settings applied to the image. 
If you hold the Option key, you’ll 
cause the OK button to change to 
Update. Updating an image will 
apply the Camera Raw settings and 
update the thumbnail and preview 
images, but will not open the image 
in Photoshop.

Photoshop can attach Camera 
Raw settings to your RAW files 
in two ways: In the Camera Raw 
database, or in sidecar .xmp files. 
You can choose between these 
two options in the Camera Raw 
preferences dialog box I mentioned 
near the beginning of this tip. I 
prefer to save my Raw setting in 
.xmp files because the advantages 
are numerous: 

1. The Raw settings will be 
used regardless of which copy of 
Photoshop is used, 

2. The settings can be burned to 
CD or DVD along with the RAW 
files, so they can be used from any 
machine, 

3. There isn’t one central hidden 
file that contains all the Raw 
settings for your images and it is 
therefore much more difficult to 
have the information deleted or 
corrupted. The disadvantage is 
that you have to deal with twice 
as many files. For each Raw image 
you have adjusted, you’ll also have 
a tiny .xmp file of the same name. 
Changing the name of the Raw file 
without doing the same to the .xmp 

file will break the bond between 
the two files, therefore preventing 
Photoshop from reading the proper 
Raw settings. That’s a small price to 
pay for the added functionality that 
.xmp files provide.

I’ve started a brand new Blog 
(blog=journal on the web) at www.
whereisben.com that features 
information about Photoshop, 
digital photography, travel and 
more. Today’s entry is about how 
Adobe accidentally announced 
Photoshop CS2!

I’ve also started up the 
Photoshop Question Clinic again. 
If you’d like to submit your own 
Photoshop questions, then visit 
www.digitalmastery.com/questions 
and visit my new blog at www.
whereisben.com to find answers to 
common Photoshop questions.

And for those of you who have 
been waiting for me to get my new 
training DVDs off the ground, 
they’re finally here! My first two 
titles are Mastering Color and 
Advanced Masking 

Information about the new 
titles can be found at www.
digitalmastery.com/DVD

Ben Willmore  
www.digitalmastery.com

Do the Math When Up-Resing 
Images

When up-resing images, you 
might get better results by using a 
resolution number that multiplies 
evenly to the resolution of your 
printed output. For example, if 
you are printing at 720 dip, using 
a resolution of 360 or 180 dpi may 
work better than using a standard 
150 or 300 dpi resolution number. 
~Roy Bohnen

Great Output Magazine
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